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Tutorial do programa ADINA 8.2 
 
 
 
 Inicializando o programa ADINA 8.2 no ambiente Windows: 
 

 
Figura 1 – Inicializando o programa ADINA. 
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 Tela principal do ambiente ADINA AUI: 
 

 
Figura 2 – Tela principal do ambiente ADINA-AUI. 
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Problema da chapa com orifício sujeita à tração 
 
 O problema da chapa com um orifício sujeita à tração é ilustrado na Figura 3 (medidas em 
mm). 
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Figura 3 – Chapa com orifício sujeita à tração. 

 
 

 Na solução deste problema, demonstraremos os seguintes passos: 
 
1. Definindo os dados de controle do modelo 

- Definindo um título para o problema 
- Definindo os graus de liberdade mestres 

2. Definindo a geometria  
- Definindo os pontos  
- Definindo as linhas 
- Definindo as superfícies 

3. Definindo e aplicando as condições de contorno 
4. Definindo e aplicando as cargas 
5. Definindo o material 
6. Definindo os elementos finitos 

- Definindo os elementos 
- Definindo a densidade da malha 
- Gerando a malha 

7. Salvando o arquivo corrente, gerando o arquivo de dados do ADINA, rodando o ADINA e 
carregando o “porthole” no ADINA-PLOT. 

8. Examinando os resultados 
- Exibindo a malha deformada e inderformada 
- Exibindo bandas de tensão 
- Traçando um gráfico da tensão em uma linha 
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1. Definindo os dados de controle do problema 
 
Título: Escolha Control→Heading, digite o título “Chapa com um orifício sujeita à tração” e 
pressione OK. 
 
Graus de liberdade mestres: Escolha Control→Degress of Freedom no Menu principal, 
desabilite os botões X-translation, X-Rotation, Y-Rotation e Z-Rotation e pressione OK. A Figura 
4 ilustra as instruções anteriores. 
 

 
Figura 4 – Definição dos graus de liberdade mestres. 

 
 
2. Definindo a geometria  
 
 Abaixo é mostrado um diagrama da geometria-chave usado na definição deste modelo: 
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Figura 5 – Geometria chave. 
 

Pontos: Escolha Geometry→Points no Menu principal, e forneça as informações da Tabela 
abaixo para a caixa Point Coordinates que é apresentada na Figura 9. 
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Número dos pontos X2 X3 
1 10 28 
2 0 28 
3 0 10 
4 0 5 
5 5 0 
6 10 0 
7 10 10 
8 0 0 

(você pode deixar a coluna X1 em branco). Então pressione OK.  
 

 Habilitando todas as opções em View→Toolbars na tela principal do ambiente ADINA-
AUI, você pode usufruir de outra alternativa para acessar a caixa Point Coordinates, opção essa 
mostrada na Figura 6. 
 

 
Figura 6 – Forma alternativa para acessa a caixa Point Coordinates. 

 Aqui, nós necessitamos de um ponto intermediário ao longo da borda do furo. A 
coordenada deste ponto é convenientemente estabelecida pelo uso de um sistema de coordenadas 
cilíndricas. Escolha Geometry→Coordinate Systems... no Menu principal, depois clique em Add 
na caixa Define Coordinate System, escolha Cylindrical  em Type e pressione OK. A Figura 7 
ilustra a caixa Coordinate System que é usada para definir o sistema de coordenadas.  
 

 
Figura 7 – Definição do sistema de coordenadas cilíndricas.  
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 A caixa de diálogo Define Coordinate System também pode ser acessada como ilustrado na 
Figura 8: 
 

 
Figura 8 – Forma alternativa para acessa a caixa Define Coordinate System. 

 
 Então, escolha Geometry→Points, adicione a informação abaixo e pressione OK. 
 

Número do ponto X1 X2 X3 System 
9 5 45 0 1 

 
 A Figura 9 mostra a caixa Point Coodinates para as coordenadas dos pontos da geometria 
do modelo: 
 

 
Figura 9 – Caixa Point Coordinates para os pontos da geometria. 

 
 A janela gráfica mostrará algo como a Figura 10: 
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Figura 10 – Pontos da geometria na janela gráfica do ambiente ADINA-AUI. 

 
Linhas: Para definir as linhas de arcos, escolha Geometry→Lines→Define... no Menu principal 
ou use a alternativa ilustrada na Figura 11. 
 

 
Figura 11 – Alternativa para acessa a caixa Define Line. 

Logo, clique em Add... na caixa Define Line e escolha Arc em Type, verifique se Defined 
by apresenta – P1, P2, Center – e entre 4 para P1, 9 para P2, 8 para Center e pressione Save. 
Então adicione o segundo arco, entrando com 9 para P1, 5 para P2, 8 para Center e pressione 
OK. Outra maneira para  fornecer os pontos para o arco definido pela opção P1, P2, Center pode 
ser realizada graficamente, ou seja, pressionando o botão P em Starting Point, P1 e clicando com 
o botão esquerdo do mouse nos pontos apresentados na janela gráfica do ADINA-AUI. 
 A Figura 12 ilustra a caixa Define Line que é usada para definir as linhas da geometria do 
modelo. 
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Figura 12 – Caixa Define Line usada para a definição das linhas da geometria. 

 A Figura 13 ilustra os arcos definidos pelas instruções dadas anteriormente: 
 

 
Figura 13 – Apresentação dos arcos na tela gráfica do ADINA-AUI. 

 
Superfícies: Para definir as superfícies, escolha Geometry→Surfaces→Define... no Menu 
principal ou use a opção da Figura 14, para acessar a caixa Define Surface. 
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Figura 14 – Alternativa para acessar a caixa Define Surface.  

Em seguida, clique em Add na caixa Define Surface e escolha Vertex em Type. Para definir a 
superfície 1 entre com 7, 3, 4 e 9, para os quatros pontos dos vértices e pressione Save. Defina as 
superfícies 2 e 3 de forma similar usando os dados abaixo: 
 

Número da superfície Ponto 1 Ponto 2 Ponto 3 Ponto 4 
2 7 9 5 6 
3 1 2 3 7 

 
então pressione OK.  
 Aqui você pode também usar o botão P em Vertices para a caixa Define Surface para 
capturar os pontos que define a superfície a ser criada. 
 A Figura 15 ilustra a caixa Define Surface que é usada para definir as superfícies da 
geometria do modelo. 
 

 
Figura 15 – Caixa Define Surface usada para a definição das superfícies. 

 Para visualizar os números dos pontos, das linhas e das superfícies da geometria do 
modelo, escolha Display→Geometry/Mesh Plot→Modify no Menu principal. Na caixa Modify 
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Mesh Plot pressione o botão Point Depiction... em Geometry Attributes para acessar a caixa 
Define Point Depiction, em seguida, pressione o botão Display Point Number em Number 
Attributes e pressione OK. De maneira semelhante, procede-se com as linhas, isto por meio do 
botão Line depiction..., e com as superfícies, com o botão Surface Depiction... . Para a 
visualização dos números pressione OK. As figuras 16 e 17 ilustram as caixas Modify Mesh Plot 
e Define Point Depiction  discutidas nas instruções anteriores. 
 

 
Figura 16 – Caixa Modify Mesh Plot. 

 

Figura 17 – Caixa Define Point Depiction. 

 A Figura 18 ilustra a janela gráfica do ADINA-AUI com a numeração dos pontos, das 
linhas e das superfícies para o problema da chapa com orifício sujeita a tração: 
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Figura 18 – Numeração dos pontos, das linhas e das superfícies da chapa com orifício. 

3. Definindo e aplicando as condições de contorno 
 
 É necessário adotar duas condições de contorno para modelar a simetria. Para definir as 
condições de contorno, escolha Model→Boundary Conditions→Define Fixity... no Menu 
principal. Escolha Add  na caixa Define Fixity, que é ilustrada na Figura 19, e forneça um nome, 
por exemplo, ZT, que será exibido em Fixity Name, para fixar os movimentos de translação na 
direção Z, habilite Z-Translation em Fixed Degrees of Freedom e pressione Save. Para fixar os 
movimentos de translação da direção Y, pressione novamente o botão Add , defina um nome, por 
exemplo YT e habilite  Y-Translation. 
 

 

Figura 19 – Caixa Define Fixity usada para definir as condições de contorno. 

 Outra forma para estabelecer as condições de contorno pode ser feita conforme ilustrado na 
Figura 20. 
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Figura 20 – Forma alternativa para estabelecer e aplicar as condições de contorno. 

 Este procedimento acessa diretamente a caixa Apply Fixity. Antes, porém, necessitamos 
definir as condições de contorno na caixa Define Fixity, como discutido anteriormente.  
 Para aplicar as condições de contorno, pressione o botão Apply Fixity... (isto se você 
estiver na caixa Define fixity) e escolha Line em Apply to:, então atribua a condição YT para as 
linhas 4 e 9 e ZT para a linha 6; para finalizar, pressione OK. A Figura 21 ilustra a seqüência de 
operações apresentadas anteriormente. 
 

 
Figura 21 - Caixa Apply Fixity usada para aplicar as condições de contorno. 

 
 A aplicação das condições de contorno também pode ser realizada através dos recursos 
gráficos do ambiente ADINA-AUI. Assim, para cada linha da tabela da caixa Apply Fixity 
escolha o nome na coluna Fixity... , isso usando o botão esquerdo do mouse. Para aplicar a 
condição de contorno, realize um duplo clique com o botão esquerdo do mouse na coluna Line#, 
que está destacada em verde, e clique com o botão esquerdo do mouse na linha desejada da 
geometria. Para finalizar, tecle Esc para retornar à caixa Apply Fixity e OK.  
 
 Para visualizar escolha Display→Show Boundary Conditions→Default no Menu principal, 
ou a opção apresentada na Figura 22. 
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Figura 22 – Forma alternativa para visualizar as condições de contorno. 

 A Figura 23 mostra as condições de contorno para o modelo: 
 

 

Figura 23 – Condições de contorno para o problema da chapa com orifício. 
 
4. Definindo e aplicando cargas 
 
 Escolha Model→Loading→Apply no Menu principal, na caixa Apply Load escolha 
Pressure em Load type e pressione Define..., pressione Add..., entre com –25 em Magnitude1 
para a pressão e pressione OK. A Figura 24 ilustra a caixa Define Pressure. 
 

                                                
1 O valor negativo (-25) fornecido para a pressão ocorre devido a orientação da normal à linha de aplicação da 
pressão. 
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Figura 24 – Caixa Define Pressure usada para definir as cargas tipo Pressure. 

 Na caixa Apply Load certifique-se que o campo Apply to está selecionado em Line. Para 
Site#, que está destacado em verde, entre com o valor 8 ou aplique um duplo clique com o botão 
esquerdo do mouse e clique na linha onde você deseja aplicar a carga; para desativar tecle ESC; 
então, pressione OK. A Figura 25 ilustra a seqüência de operações discutida anteriormente. 
 

 
Figura 25 – Caixa Apply Load usada para aplicação da carga de pressão. 

 Para visualizar escolha Display→Load Plot→Use Default no Menu principal, ou a opção 
da tela apresentada na Figura 26. 
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Figura 26 – Forma alternativa para visualizar as cargas. 

 A Figura 27 mostra o carregamento para o problema da chapa com orifício. 
 

 

Figura 27 – Visualização das cargas no problema da chapa com orifício. 

 
5. Definindo o material 
 
 Escolha Model→Material→Elastic→Isotropic... no Menu principal, pressione em Add e 
entre com 7E4 para Young’s Modulus, 0.25 para Poisson’s Ratio e pressione OK. A Figura 28 
ilustra a caixa Define Isotropic Linear Elastic Material usada para a definição das propriedades 
do material para o problema da chapa com orifício. 
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Figura 28 – Caixa Define Isotropic Linear Elastic Material usada para a definição das 

propriedades do material. 

 
6. Definindo os elementos finitos 
 
Definindo os elementos 
 
 Escolha Meshing→Element Groups... no Menu principal, pressione Add, escolha 2-D Solid 
em Type e Plane Stress em Element Sub-Type e pressione OK. A Figura 29 ilustra a caixa Define 
Element Group. 
 

 
Figura 29 – Caixa Define Element Group usada para a definição do tipo de elemento. 
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Definindo a densidade da malha 
 
 Vamos adotar uma malha com um tamanho de elemento uniforme para todos os pontos da 
geometria. Escolha Meshing→Mesh Density→Complete Modet e verifique se a opção Use End-
Point Sizes em Subdivision Mode está selecionada e pressione OK. Escolha Meshing→Mesh 
Density→Point Size..., depois selecione All Geometry Points em Points Defined From, entre com 
2.0 em Maximum para Mesh Size, pressione Apply e OK. A Figuras 30 e 31 ilustram os passos 
anteriores. 
 

 
Figura 30 – Definição da densidade da malha. 

 
Figura 31 - Definição da densidade da malha. 

 
 A Figura 32 ilustra as divisões para a malha: 
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Figura 32 – Divisão das linhas da geometria da chapa com orifício para geração da malha. 

 
 Para gerar os elementos, escolha Meshing→Create Mesh→Surface..., entre 1, 2 e 3 nas três 
primeiras linhas da tabela de Surface, pressione OK. A Figura 33 ilustra as instruções anteriores. 
 

 
Figura 33 - Caixa Mesh Surface para geração da malha em superfície. 

 A Figura 34 ilustra a malha de elementos finitos para o modelo da chapa com orifício. 
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Figura 34 – Visualização da malha para o problema da chapa com orifício. 

 
 Nota-se na Figura 34 que a malha próxima ao furo não está muito bem definida. Nós 
gostaríamos de refiná-la próximo ao furo, adicionando mais elementos. Escolha 
Meshing→Delete Mesh no Menu principal, na caixa Delete Mesh, conforme mostrada na Figura 
35, escolha Surface em Delete Mesh from, então entre com 1 e 2 para Surface #, pressione OK.  
 

 
Figura 35 – Caixa Delete Mesh usada para “deletar” as malhas das superfícies. 

 
 A Figura 36 ilustra o resultado das instruções anteriores na janela gráfica do ADINA-AUI. 
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Figura 36 – Visualização do resultado do cancelamento das malhas nas superfícies 1 e 2. 

 
 Agora vamos aumentar a densidade da malha para os pontos no contorno do furo. Escolha 
Meshing→Mesh Density→Point Size..., entre com 1.0 na tabela de Mesh Size para os pontos 4, 5 
e 9, pressione OK. A Figura 37 ilustra os passos anteriores. 
 

 
Figura 37 – Redefinindo na caixa Define Point Size a divisão para as linhas da geometria da 

chapa com orifício para a geração da malha. 

 
 A Figura 38 mostra o resultado das instruções anteriores para a janela gráfica do ADINA 
AUI. 
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Figura 38 – Visualização da nova divisão das linhas das superfícies 1 e 2 para o refinamento da 

malha próximo ao orifício. 

 Agora vamos adicionar os elementos nas superfícies 1 e 2. Escolha Meshing→Create 
Mesh→Surface... , entre 1 e 2 para as duas primeiras linhas da tabela de Surface, pressione OK. 
A Figura 39 ilustra a geração da malha mais refinada próximo ao orifício da chapa. 
 

 
Figura 39 – Visualização da malha refinada próximo ao orifício da chapa. 

 
 

7. Salvando o arquivo, gerando o arquivo de dados do ADINA, rodando o ADINA e 
carregando o “porthole” no ADINA-PLOT 
 
Salvando o arquivo corrente (*.idb) 
 
 Para salvar o seu arquivo corrente, entre em File no Menu principal do ADINA-AUI , 
escolha Save As, aparecerá uma caixa como ilustrada na Figura 40, entre com um nome em File 
name e pressione Save. 
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Figura 40 – Salvando um arquivo *.idb. 

Gerando o arquivo para o processador do ADINA (*.dat) e rodando o ADINA 
 
 Acesse Solution→Date File/Run... no Menu principal, aparecerá uma caixa como ilustrada 
na Figura 41, entre com um nome em File name e pressione Save. Note que, em seguida, uma 
janela como mostrada na Figura 42 irá surgir. Esta janela indica o resultado da compilação do 
programa ADINA.  
 

 
Figura 41 – Criando o arquivo *.dat 
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Figura 42 – Resultado da compilação do programa ADINA. 

  
 Sendo o resultado da compilação realizado com sucesso. A Figura 43 mostra a mensagem 
que o processamento do arquivo *.dat foi completado. 
 

 
Figura 43 – Resultado do processamento do programa ADINA. 
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Carregando o “porthole” no ADINA-PLOT 
 
 Após o processamento ter sido completado com sucesso, acione o ADINA-PLOT, segundo 
Figura 44, em seguida, abra o arquivo “porthole” em File→Open, conforme Figura 45. 
 

 
Figura 44 – Acionando o ambiente ADINA-PLOT para visualização dos resultados. 

 

 
Figura 45 – Abrindo um arquivo “porthole” no ambiente ADINA-PLOT. 

 Ressalta-se que, ao longo dos trabalhos realizados no ambiente ADINA-AUI ou ADINA-
PLOT, um arquivo ASCII com extensão *.ses vai sendo gerado. Este arquivo armazena todos os 
passos desenvolvidos em tais ambientes e pode ser usado para gerar um arquivo BATCH, arquivo 
de comandos, que pode ser rodado no  programa ADINA. 
 
 
8. Examinando os resultados (Pós-processamento) 
 
Visualizando a malha deformada e indeformada 
 
 Ao abrir o arquivo “porthole”, a malha deformada já será visualizada, conforme indicado 
na Figura 46. 
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Figura 46- Malha deformada. 

 Para visualização da malha indeformada, escolha Display→Geometry/Mesh 
Plot→Modify... no Menu principal; na caixa Modify Mesh Plot, ilustrada na Figura 16, entre em 
Model Depiction... , para acessar a caixa Define Model Depiction; nesta caixa para Model 
Display options habilite Show Original Mesh e para Displacement Display Option, forneça o 
valor de 100, por exemplo, para Magnifaction Factor; e para finalizar, pressione OK. Para 
visualização pressione OK na caixa Modify Mesh Plot . A Figura 47 mostra a caixa Define Model 
Depiction para a seqüência de instruções fornecidas anteriormente. 
 

 
Figura 47 – Caixa Define Model Depicition usada para a visualização da malha deformada e 

indeformada.  

A Figura 48 ilustra a malha deformada e indeformada. 
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Figura 48 – Visualização da malha deformada e indeformada. 

 
Visualizando as bandas de tensão 
 
 Antes, para uma melhor visualização, limpe a janela gráfica do ADINA-PLOT 
escolhendo Display→Clear Window e então escolha Display→Geometry/Mesh Plot→ Use Default 
no menu principal para mostrar uma nova malha. 
 
 Para visualizar as bandas de tensão, escolha Display→Band Plot→Create... no Menu 
principal ou a alternativa indicada na Figura 49.  
 

 
Figura 49 – Alternativa para acessar a caixa Create Band Plot with Default Style. 

Em seguida, na caixa Create Band Plot, ilustrada na Figura 50, para Band Plot Variable 
escolha Stress e STRESS-ZZ, e pressione OK. 
 

 
Figura 50 – Caixa Create Band Plot usada para a visualização das bandas de tensão. 
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 A Figura 51 ilustra as bandas de tensão STRESS-ZZ para o problema da chapa com 
orifício. 
 

 

Figura 51 – Bandas de tensão – STRESS-ZZ para o modelo da chapa com orifício. 

Traçando um gráfico das tensões para uma linha 
 
 Primeiramente, vamos carregar o arquivo *.idb que contém informações sobre a geometria. 
Dessa forma, podemos extrair resultados de nós de uma linha sem a necessidade de selecionar nó 
por nó. 
 Dentro da ADINA-PLOT, abra o arquivo *.idb em File→Open, conforme mostrado na 
Figura 52. Na janela gráfica do ADINA_PLOT aparecerá o seu modelo construído no ADINA-
AUI. 
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Figura 52 – Abrindo o aquivo *.idb no ADINA-PLOT. 

 
 Em seguida abra o arquivo *.por em File→Open, igual mostrado na Figura 45. 
 
 Caso as condições de contorno e o carregamento estejam sendo mostrados, pode-se acessar 
Display→Boundary Conditions→Use Default para não mostrar as condições de contorno e 
Display→Load Plot→Use Default para omitir o carregamento. Outra alternativa é usar os ícones 
mostrados nas figuras 22 e 26. 
 
 A Figura 53 mostra a janela gráfica com os números dos pontos, das linhas e das 
superfícies. 
 

 
Figura 53 – Numeração dos pontos, das linhas e das superfícies da chapa com furo no ADINA-

PLOT. 
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 Outra forma para visualização dos números das linhas pode ser realizada conforme 
ilustrado na Figura 54. 
  

 
Figura 54 – Alternativa para visualização dos números das linhas e destaque do ícone do zoom 

 
 Para facilitar a identificação da linha onde desejamos obter o gráfico das tensões, nós 
podemos dar um zoom na região da linha. Com o mouse, pressione no ícone do zoom, que está 
destacado na Figura 54, feche uma caixa com o cursor (lupa) na região próxima ao orificio e 
pressione o botão esquerdo do mouse. A Figura 55 ilustra um zoom de uma região próxima ao 
orifício. 
 

 
Figura 55 – Zoom para visualização da numeração das linhas para a região próxima ao orifício. 

 
 Agora vamos traçar um gráfico das tensões na linha horizontal de simetria (linha 6). Para 
fazer isto, criamos uma “linha de nós”, na qual lista os nós na linha horizontal de simetria. 
Assim, escolha Definitions→Model Line→General no Menu principal; na caixa Define Node 
LineFrom Selected Entities pressione Add e forneça um nome, por exemplo, “linha-simetria”. 
Em seguida, digite “Geometry line 6” em Contents e selecione Along Parametric em Direction 
para que os nós sejam ordenados na direção da linha, neste caso, da esquerda para a direita e 
pressione OK. A Figura 56 ilustra a seqüência de operações anteriores. 
 

zoom 
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Figura 54 – Caixa Define Geometry Node Line usada para definição de uma linha com nós 

Antes, para uma melhor visualização, limpe a janela gráfica do ADINA-PLOT 
escolhendo Display→Clear Window. 

 
Agora escolha Graph→Response Curve (Model Line)... no Menu principal. Na caixa 

Display Response Curve (Model Line), para X Coordinate, escolha Coordinate para Variable e 
DISTANCE. Para Y Coordinate, escolha Stress para Variable, STRESS-ZZ e escolha também 
AVERAGED em Smoothing Technique; e pressione OK. A Figura 55 mostra a seqüência de 
instruções anteriores. 
 

 
Figura 55 – Caixa Display Response Curve (Model Line) usada para traçar um gráfico das 

tensões para uma linha. 
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 A Figura 56 mostra o gráfico da tensão STRESS-ZZ para a linha horizontal de simetria. 
 

 
Figura 56 – Gráfico das tensões STRESS-ZZ para a linha horizontal de simetria. 

 


